
LOCALNERDS.CO  /  TIM COLE

SESSION 01 · COMPANION GUIDE

DBJ Scheduled
Research Setup.
A daily ChatGPT task that lands your shortlist before
6am.

For    Tim Cole, Vistage Chair · Denver & Colorado Springs

From    Reuben “Reu” Smith · Local Nerds

Session    1 follow-through · Recruiting Automation engagement

Date    April 22, 2026

Built for Tim Cole by Local Nerds timc.localnerds.co



2 / 12Tim Cole × Local Nerds · Session 1

Tim — DBJ Scheduled Research
Setup

Time to complete: ~15 minutes

Every morning by 6am MT, a scheduled ChatGPT task posts a ready-to-paste list of new Denver
Business Journal signals — CEO appointments, acquisitions, expansions — directly into your

ChatGPT thread. Each row is pre-enriched with Title, Company, Industry, Revenue Band
estimate, a LinkedIn search link, the Recent Signal from the article, and a drafted Intrigue Hook

phrase. You open ChatGPT at 6:30, glance at the list, copy-paste the rows into a new tab of
your tracker, claim the good ones in Vistage, and you’re in your cadence. The Intrigue Hook is

already written for emails #1 and #3.

This is the Session 1 follow-through I promised you on yesterday’s call. Seven steps below, in

order. Each has a copy-paste block.

I initially wanted this to write directly into your Excel file while you slept. ChatGPT’s current

Microsoft connector is read-only and can’t append rows to Excel, so the design shifted to “task
outputs a paste-ready list at 5:45am, you copy it into your workbook at 6:30am.” That’s a 30-

second paste step per morning, in exchange for a curated shortlist that would have taken you
an hour to build by hand. Net win.

Open your recruiting workbook in Excel. Right-click any existing Group tab → Insert →
Worksheet. Rename it: Prospect Pipeline .

Paste the following into cell A1 (it’s tab-separated — Excel will split it across 15 cells when you
paste):

What you’ll have when you’re done

A quick note on architecture

Step 1 — Add a new tab to your tracker: Prospect

Pipeline
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Date    Signal  First   Last    Company Title   Industry    Est. Revenue Band   City

LinkedIn Search Recent Signal   Intrigue Hook   Source URL  Status  Notes

If the columns don’t split: paste into Word first, select all, Table → Convert Text to Table (tab-
separated), then copy the resulting table into Excel. Or use Data → Text to Columns with Tab as

the delimiter.

Save the workbook. This tab is the home for all incoming DBJ signals. Your existing Group tabs

stay untouched.

Open your existing Custom GPT (the one from yesterday’s call with the /enrich  Action

configured). Click the GPT’s name at the top → Edit GPT → Configure tab.

2a. Add two conversation starters

Scroll down to Conversation starters. Add these two:

1. Full research [paste a name]

2. Pull latest DBJ Fastest-Growing list

2b. Append to the Instructions

Scroll up to Instructions. At the very bottom of the existing text, paste this block:

Step 2 — Update your Custom GPT
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=== DBJ Prospect Research Support (added 2026-04-22) ===

You support two Tim-initiated commands related to the Prospect Pipeline tab in his recruiting

workbook:

1. "Full research [name]" or "Full research [name] at [company]"

- Call the /enrich Action configured in this GPT with {name: "First Last", notes: "[any

notes Tim gave]"}

- Take the returned dossier and format it as a replacement row Tim can paste into his

Prospect Pipeline tab

- Keep the original row structure: Date, Signal (unchanged), First, Last, Company, Title,

Industry, Est. Revenue Band, City, LinkedIn Search, Recent Signal (strongest from dossier),

Intrigue Hook (strongest single candidate from dossier), Source URL (unchanged), Status =

"Researched", Notes (append any flags from the dossier prefixed "Flags:")

2. "Pull latest DBJ Fastest-Growing list"

- Search the web for "Denver Business Journal Fastest-Growing Companies" for the current

year

- For each company on the list that's a private Denver-area company, produce a row matching

the Prospect Pipeline schema

- Signal = "fastest-growing". Source URL = the list page URL.

- Output as a tab-separated markdown table Tim can paste into his workbook

INTRIGUE HOOK VOICE (applies everywhere)

- Peer-to-peer, CEO to CEO. Not vendor-to-prospect.

- Anchored to the Recent Signal directly. No generic hooks.

- BANNED words: "impressive", "inspiring", "innovative", "exciting", "amazing", "remarkable"

- Fills this slot: "intrigued by your ___ and business leadership"

- Short. Should flow when read aloud.

LINKEDIN URL RULE

Never invent or guess a LinkedIn profile URL. If you need to provide one, construct a Google

search URL of the form:

https://www.google.com/search?q=site%3Alinkedin.com%2Fin+%22First+Last%22+%22Company%22

=== END DBJ Prospect Research Support ===

Click Update (top-right) to save.

Important: the daily scheduled scan does NOT run inside this Custom GPT. ChatGPT’s

scheduled tasks don’t support Custom GPTs yet. The scan is set up separately in Step 3 below
and runs in regular ChatGPT with its own self-contained prompt.
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In ChatGPT (the web app or desktop), open a regular new chat — NOT inside your Custom GPT.

Pick any model (GPT-4o is fine).

Paste this entire message into the chat and send:

Step 3 — Create the daily 5:45am scheduled task
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Create a scheduled task:

Name: DBJ Morning Scan

Schedule: Every day at 5:45am America/Denver time

Prompt:

Run the Denver Business Journal morning scan. Output a paste-ready markdown table. Do NOT

attempt to write to any file.

SOURCE (do not try bizjournals.com directly — it is Cloudflare bot-blocked):

Fetch this Google News RSS URL and parse for recent items:

https://news.google.com/rss/search?

q=site%3Abizjournals.com%2Fdenver+%28CEO+OR+President+OR+named+OR+appointed+OR+acquires+OR+acq

uisition+OR+expands+OR+expansion+OR+headquarters+OR+growing%29&hl=en-US&gl=US&ceid=US:en

Keep items with pubDate within the last 7 days.

SIGNAL TYPES TO KEEP

- new-ceo: CEO, President, Owner, or Managing Partner named or appointed at a private company

- acquisition: company acquired, acquired-by, or made an acquisition

- expansion: expansion, new HQ, new location, significant hiring event

- new-hq: relocating or opening Denver-area headquarters

SIGNAL TYPES TO SKIP

- Funding rounds under $10M (too early-stage)

- 40 Under 40 (over-pitched)

- Denver Inno startup coverage (too early-stage)

- Public-company earnings, government, nonprofit, municipal news

GEOGRAPHIC FILTER (~25 miles of downtown Denver)

KEEP: Denver, Aurora, Centennial, Lakewood, Englewood, Arvada, Littleton, Thornton,

Westminster, Wheat Ridge, Commerce City, Greenwood Village, Glendale, Broomfield (south),

Parker, Lone Tree, Highlands Ranch, Golden.

SKIP: Colorado Springs, Fort Collins, Boulder, Loveland, Longmont, Greeley, Pueblo, Grand

Junction, Vail, Aspen.

LITE ENRICHMENT PER ITEM

For each surviving item, try to fetch the DBJ article page via browsing. If the article page

fails to load (Cloudflare block), use the Google News title and snippet only.

Produce these fields per row:

- Date: today's date (YYYY-MM-DD)

- Signal: one of the tags above

- First, Last: the person named (blank if the article is about the company without naming an

executive)
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- Company: company name

- Title: CEO / President / Founder / Owner / Managing Partner (blank if not stated)

- Industry: 1 to 3 words (e.g., "Logistics", "Healthcare IT", "Commercial Real Estate")

- Est. Revenue Band: $5-10M, $10-25M, $25-50M, $50-100M, $100-250M, $250-500M, or BLANK. Only

fill when there is a strong cue (employee count with known industry multiples, stated revenue,

acquisition deal size). BIAS STRONGLY TO BLANK. A wrong guess costs Tim a claimed Vistage

slot. Blank is better than wrong.

- City: HQ city (from KEEP list only)

- LinkedIn Search: Google search URL of the form https://www.google.com/search?

q=site%3Alinkedin.com%2Fin+%22First+Last%22+%22Company%22 — never invent or guess a profile

URL

- Recent Signal: one specific sentence from the article (quote or tight paraphrase, not

generic)

- Intrigue Hook: best single phrase completing "intrigued by your ___ and business leadership"

— anchored to the Recent Signal, peer-to-peer voice, BANNED words: impressive, inspiring,

innovative, exciting, amazing

- Source URL: DBJ article URL

- Status: "New"

- Notes: prefix "Hook alts:" then list 2 alternate Intrigue Hook candidates semicolon-

separated

OUTPUT FORMAT

Reply with:

Line 1: "5:45am DBJ scan — [N] items, last 7 days. Paste the table below into the Prospect

Pipeline tab (Tab key will split columns):"

Line 2: blank

Lines 3+: a tab-separated table with the 15 columns in this order:

Date    Signal  First   Last    Company Title   Industry    Est. Revenue Band   City

LinkedIn Search Recent Signal   Intrigue Hook   Source URL  Status  Notes

Use literal TAB characters between columns, one row per line, no markdown pipe characters.

ZERO-HIT CASE

If no items survive filtering: reply "5:45am DBJ scan — no new signals in the last 7 days."

SOURCE-UNREACHABLE CASE

If Google News RSS is unreachable or returns no items: reply "5:45am DBJ scan — Google News

unreachable this morning, will retry tomorrow."

DEDUP

Do not attempt to dedup. Tim will eyeball against his existing Prospect Pipeline tab before

pasting rows. The Source URL is the dedup key if he wants to remove duplicates later via

Excel's Remove Duplicates feature.
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Send that whole block. ChatGPT will read it, propose a schedule, and ask you to confirm. Say
yes / confirm. A “task” bubble will appear in the chat.

To see and edit your tasks later: click your profile icon (bottom-left) → Tasks.

In your Tasks list (profile icon → Tasks), find DBJ Morning Scan and click the three-dots menu →
Run now (or the equivalent manual-trigger button — OpenAI has moved this around; if you
don’t see Run, just edit the task, save, and wait for the next trigger, or send yourself a fresh

“run DBJ Morning Scan now” message).

Wait 2–5 minutes. A new chat thread should open with the scan output.

Expected output: a line like “5:45am DBJ scan — 3 items, last 7 days. Paste the table below…”
followed by a tab-separated table with 3 rows.

If you see that, you’re done. Copy the table (everything from the Date header line down), paste
into cell A2 of your Prospect Pipeline  tab, and you’re live.

1. 6:30am. Open ChatGPT. Look for the “DBJ Morning Scan” thread (should have a fresh
message from 5:45am).

2. Scan the table. 1–5 rows most mornings.

3. Eyeball for duplicates against what’s already in your Prospect Pipeline tab. If a Source URL is
already there, skip that row.

4. Copy the table rows you want to keep → paste into the next empty row of your Prospect
Pipeline tab. Excel will split columns on the tab characters.

5. Open Vistage portal, claim the ones you want. Update the row’s Status column from New  to
Claimed .

6. Grab emails from Lusha or the Vistage CRM.

7. Copy First, Last, Company, Email from the Prospect Pipeline row into your current Group tab.

Update Pipeline Status to Pursuing .

Step 4 — Test the task once manually

Step 5 — Your daily morning routine
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8. Run your 8-step cadence as today. Email #1 and #3 both reference the Intrigue Hook column
from Prospect Pipeline.

Optional upgrade for a specific prospect: in your Custom GPT say “Full research [name]” — the
GPT calls the deeper research engine and hands you back a stronger Intrigue Hook and flags.

Paste the updated row back over the original in Prospect Pipeline, Status = Researched .

Profile icon → Tasks → find DBJ Morning Scan → three-dots menu → Pause (temporarily) or

Delete (permanently).

Rows already in your workbook stay. Delete them manually if you want. Re-enabling any time

resumes the morning scans.

ChatGPT’s task UI has shifted a few times in 2026. If any part of the setup behaves

unexpectedly, paste the matching prompt below into a fresh ChatGPT chat. These are written
to give ChatGPT the full context in one message so it can help you figure out what’s happening,

without you needing to know the current menu layout.

Step 6 — How to kill the scan if it misbehaves

Step 7 — Self-diagnostic prompts if something’s off
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Diagnostic A — “The task didn’t fire this morning / no new message

appeared in the DBJ thread”

I set up a scheduled task in ChatGPT called "DBJ Morning Scan" that should fire at 5:45am

America/Denver every day and post a message in its thread. Today I opened ChatGPT at [TIME]

and there's no new message from it.

Please walk me through how to:

1. Verify the task is actually active — where exactly is the tasks list in the current ChatGPT

UI (desktop web app, as of today)?

2. Check the task's last run status and any error it hit.

3. Manually trigger it now to see if it runs at all.

4. Check whether I'm hitting the 10-active-tasks cap that ChatGPT Plus has.

Tell me the exact clicks in the current UI, and if a screenshot would help, tell me what to

capture.

Diagnostic B — “The task ran but produced no table / said ‘no new

signals’ every day for 3+ days”

My scheduled task "DBJ Morning Scan" has been running but for the last 3+ days it has either

output "no new signals in the last 7 days" or returned an empty result. I know for a fact that

the Denver Business Journal has published CEO appointment and acquisition articles in that

window.

The task fetches this URL:

https://news.google.com/rss/search?

q=site%3Abizjournals.com%2Fdenver+%28CEO+OR+President+OR+named+OR+appointed+OR+acquires+OR+acq

uisition+OR+expands+OR+expansion+OR+headquarters+OR+growing%29&hl=en-US&gl=US&ceid=US:en

Please do three things:

1. Fetch that URL right now and tell me how many items are in it with pubDate in the last 7

days, and list the first 5 headlines.

2. If there ARE items there, tell me which of my filters (signal types, geographic filter for

Denver metro, exclusions) would be cutting them out.

3. Suggest a loosened version of the filters we could try for one week as a calibration test.
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Diagnostic C — “The table has bad rows (wrong regions, wrong

industries, obviously not my ICP)”

My scheduled task "DBJ Morning Scan" is producing rows that don't match my ICP. Here are 3

recent bad rows [PASTE THE BAD ROWS HERE].

My ICP is: private-company CEOs/Presidents, $5M-$500M revenue, HQ within 25 miles of downtown

Denver. I'm the Vistage chair — I recruit for CEO peer-advisory groups.

Please:

1. Tell me WHY each of these rows got through the filter — which keyword matched, which

geographic filter was too loose.

2. Suggest a specific tightening for each bad row that wouldn't also kill good rows.

3. Give me a replacement version of the filter block in my task prompt that I can paste in.

Diagnostic D — “The Custom GPT’s ‘Full research [name]’ command

isn’t working”

I have a ChatGPT Custom GPT set up by my consultant with an Action that calls a research

endpoint. I tried saying "Full research [name]" and one of these things happened: [PICK ONE

AND DESCRIBE:

(a) it didn't call the Action at all, just made up an answer

(b) the Action returned an error

(c) the answer came back but not in the row format I expected].

Walk me through:

1. Confirming the Action is still configured — where do I look in the GPT's Configure panel?

2. Testing the Action directly (not through conversation) to see what it returns.

3. If it's making up answers without calling the Action, what's the fix?

This is a ChatGPT Plus account. The GPT was working yesterday.

1. Vistage portal automation. You said manual, it stays manual.

2. LinkedIn Sales Navigator search on your connections. Your other source. Future session.

3. Auto-scoring hungry/humble/courageous/presence. Not findable in public data; those stay
your in-conversation judgment calls.

What I intentionally didn’t build yet
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4. Automating the 8-step outreach cadence. This is what you named as your real priority. That’s
Session 2. The Intrigue Hook populated each morning is exactly what email #1 and email #3

will pull from in that work.

Copy-paste beats the original write-while-you-sleep plan. ChatGPT’s current Microsoft
connector can read your workbook but can’t write rows to it. Rather than build a Power
Automate bridge (more infrastructure you’d inherit), I kept it all in ChatGPT with a 30-second

paste step on your side.

No automatic dedup across days. If the same article runs twice in Google News’s feed, you
might see the same row two mornings in a row. Easy to eyeball and skip, or use Excel’s
Remove Duplicates on the Source URL column weekly.

The scan can’t use your Custom GPT’s Instructions. That’s why the task prompt in Step 3 is

long — all the DBJ-specific rules are baked in directly. Your Custom GPT still handles “Full
research” and “Pull Fastest-Growing list” with its own Instructions.

Text or email me. Screenshots of the ChatGPT thread after the task runs are the most useful.

Reu reu@localnerds.co · 970.800.1295

Honest trade-offs in this version

If anything goes sideways


